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Version Information

Noted below are the new features and enhancements for versions 5.0 , 6.0, 7.0, 7.5, 8.0, 8.5, 9.0, and 9.2. To go to a specific version,
select one of the links below.

Version 9.2 and 9.0
Version 8.5
Version 8.0
Version 7.5
Version 7.0
Version 6.0
Version 5.0

Keysight VEE Pro 9.2 and 9.0 New Features

Supportability

Keysight VEE 9.2 supports Windows 7 (Professional, Ultimate, and Enterprise with 32-bit and 64-bit supportability).
Note that the 64-bit support has a 32-bit application running on WOW64 (Windows-on-Windows 64-bit) emulator.

Multithreading

This feature can increase performance of your system created with Keysight VEE. With this feature, you can easily create multiple threads
in a Keysight VEE program to gain shorter execution time, faster response speed, and higher 10 throughput. A new Execution Mode is also
introduced along with the Multithreading feature.

To create a thread, from Device menu, choose ThreadObject. Following figure shows a VEE program with two Do loops. The only difference
between these two loops is that the left one is using normal UserObject while the right one is using the ThreadObject. The Timers show
their execution time. Obviously, the right one using ThreadObject is faster than the left one.

—| Timer| «

Ussrobjectd| ~ems

[ Tirner ~

321

See Overview of ThreadObject, ThreadObject for more information.

Example PerformanceComparison.vee.

Multicore Programming

This new feature provides you the Multicore Programming capability. You can gain even higher performance for your multithread programs
through allocating different threads to some specified CPU cores if your computer has a multicore CPU.

Following VEE Program shows three UseCases. Each of them contains two threads. In the UseCasel, both threads are allocated to the
same CPU core; in the UseCase2, operating system (OS) selects CPU core for both threads automatically; in the UseCase3, both threads
are allocated to different CPU cores. Timer shows execution time of each Usecase. Generally, how much the system performance can be
improved differs from application to application and depends on how CPU cores are allocated. Let OS do the allocation task automatically
unless you have rich experiences on multicore programming. Otherwise, you may encounter poor system performance.
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You can allocate a thread to a specific CPU core under Design section in the Properties window of that thread.

Example MultiCoreProgramming.vee.

SCPI Completion

Using SCPI commands to control instruments is the most flexible and efficient way to communicate with instrument. However, to
remember all SCPI commands is a great challenge, especially to a novice.

Keysight VEE 9.0 introduces SCPI Completion to solve this problem. With this feature, you can easily choose a SCPI command from a list
that appears while you are typing a SCPI command in the IO Transaction object. A description of the chosen SCPI command is also
displayed. It saves your time spent searching in SCPI manuals and checking syntax errors dramatically. Moreover, you can even choose
your own SCPI command file instead of using the default SCPI command file automatically selected by VEE.

See To Use SCPI Completion for more information.

Private UserFunction

Keysight VEE 9.0 has a new type of UserFunction -- Private UserFunction. With this feature, you can modularize your VEE programs better
and encapsulate your VEE programs for larger scale applications.

You can either create a Private UserFunction or convert an existing normal UserFunction to a Private UserFunction. Private UserFunctions in
an imported library are visible in Program Explorer, Function and Object browser, Find Results, Profiler and Formula Completion and

Insight in the importing VEE programs. All accessing to a Private UserFunction must through a public UserFunction which belongs to the
same library.

A Private UserFunction cannot contain Global variables. If a normal UserFunction is converted to private, all Global variables in that
UserFunction will be changed to Local to Library automatically. UserFunctions are not private by default when created. You can change
UserFunctions to private in Properties window or in Program Explorer after creating them.

Properties ~ 4 X

|UserFuncti0n2 [UzerFunction] - F1 j

e 24

E Appearance 1=
Title |JserFunction?

E Behavior

FrivateFunction

E Design Falze
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See About UserFunctions, To Convert Between Public and Private UserFunctions for more information.

LXI Support

All LXI instruments have a web interface that provides useful information about the instrument, a standard way to configure the LAN
interface, and other features. Keysight VEE provides a easy way to open an LXI web interface of an instrument in a VEE built-in Web
Browser.

See Introduction to LXI, LXI Web Interface, To Open LXI Web interface in VEE.

Enhanced Default Preferences

Default Preferences dialog box is reorganized and enhanced to give you not only modern programming experience but also enhanced
functionality.

Default Preferences

Default Preferences

-1 Erwironment General
General [ Default Bun in Independent Thread
Colors & Fonts ¥ Delete Variables at PreRun
Debug
Esecution Mode ¥ Enable Auto Line Riouting
Help ¥ Enable Code Complstion & Insight
Murnber " . )
Printing v Supports Built-in Functions
Program Development I Supports COM Constants
In]
v s :
MATLAR v Enable Compiler Warning
Web Server ¥ Enable SCPI Completion
¥ Dizable VEE Caution Message Box during Runtime
¥ Match Brackets in Formula

] Save t | Caticel |

See Default Preferences for more information.

New Toolbars for VEE Object

A new set of icon as well as several new toolbars are assigned to some frequently used VEE objects. It is easier to pick a VEE object from
these toolbars than from main menu. To open these toolbars, right click menu or toolbar area and choose a toolbar as needed.

Modern Dialog Boxes

Four more dialog boxes have new appearance, giving you not only modern programming experience but also enhanced functionality.
Explore the following dialogs to experience these new dialog boxes.

ActiveX Control References
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ActiveX Control References @

Registered Activer Controls Selected Activel Contrals
Ficrozoft SUL Replication Erors 9.0 ~ Microgaft Comm Control 6.0
ticrogzaft Spslnfo Contral 6.0 ticrogzoft Common Dialog Control 6.0 [SPE)

ticrozaft Tabbed Dialog Control 6.0 [SPE]

ticrozaft Tablet PC Type Library, wersion 1.0

ticrozaft Terminal Services Active Client 1.0 T, b3
ticrozaft Vizio 11.0 Drawing Contral Type Libre

Microsoft Yizio Wiewer 12.0 Type Libramy <4
Ficrozaft Wisual Studio 2005 T oolz for the Micn

Ficrozoft Wisual Studio 2005 T oolz for the Micn
bicrozaft Wisual Studio 2003 T ools for Office E:
ticrozaft \Windows Comman Contrals 5.0 [SPZ2]
ticrozaft \Windows Common Controls 6.0 [SPE
ticrozaft Windows Common Contrals-2 5.0 [SF
ticrozaft Windows Common Controls-2 6.0 [SF
Microsoft YWwWindows Common Controls-3 6.0 [SF
icrogoft \Winsock Control 6.0 [SPE)

S Video Contral 1.0 Type Libramy

b S FlenGrid wizard

Msie Active Control module bt
< |

Microzoft Visio Viewer 12.0 Type Library
Location: CHAPROGRA~TWMICROS~ 30 ffice] 23 WIEWER.DLL

0K | Cancel | Browse... | Help |

ActiveX Automation References

ActiveX Automation References

)

Registered Automation Servers Selected Automation Servers

Microzaft Development Environment W+ Proj # wcel 12.0 Object Library
icrozaft Development Environment WC++ Proj

ticrozaft DFUI 1.0 Type Library

ticrozaft DHTML Page Funtime Library 1.0

icrozaft Dialog Automation Objects b3
ticrozaft Direct< Transforms Core Type Libran,

Microsoft Direct< Transforms Image Transforms <4
Microzoft Disk Quota 1.0 =

Microgaft DT DDS Typelib 2

ticrozaft FrontPage 6.0 Page Object Referenc
ticrozaft FrantPage 6.0 Web Object Feferenc
ticrozaft Graph 12.0 Object Library

icrozaft H323 Service Provider 1.0 Type Libri
ticrogzoft Help Data Services 1.0 Type Library
Microsoft HTML Object Library

icrogoft InfoPath 2.0 Type Librany

Microgzaft InkDivider Type Library, version 1.5
ticrozaft InkEdit Contral 1.0

ticrozaft Internet Controls

£ | >

Microzaft Ercel 12.0 Object Library
Location: C:"Pragram Files\Microzoft Office\Dffice] 2\EXCEL EXE

0K | Cancel Browse... Help

.NET Assembly References
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.NET Assembly References E]

W Import namespaces after clazsing

MET ]CDM ]

Available References Selected References

ticrozoft Build. Engine -~ Syztem

Microsoft. Build. Framework, Syztem Wweb

Ficrozoft Build. T azks

Ficrozaft. Build. Utilities ¥

Microzoft Build.Visuall Sharp

icrozaoft CompactFramewark Build T azks <

icrozaft.JScript |

i ft Wizl

Ficrozaft WisualC

bicrozoft Vza

ticrozoft Wza Vb CodeD OMProcessor

Microsoft_Ysavb P

< [

Microzoft WisualB asic Wea

Location: A IMDDWS Sicrozoft HE T WFramesorkv2. 08072 P icrozoft WisualB asicWea.dll
Wersion: Wersion=8.0.0.0

ak | Cancel Browsze... Help
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Enhanced Custom Menu Support

Besides the Text format, XML format is also supported in Keysight VEE 9.0. Two custom menu tools are also released with Keysight VEE
9.0. They are CustomMenu Editor and CustomMenu Converter.

With the CustomerMenu Editor, you can easily customize the menus in the VEE development environment. Such as adding items to the

menus for special objects and functions you want to use frequently, and removing menu items that no longer needed. This tool provides a
graphic interface. You can specify where an menu item to add and edit its properties easily. No need to edit the text file customMenu.mnu
any more. The new menu items will not take effect until VEE is restarted.

CustomMenu Editor.
SERE(+t+¢+¥OX

- taintdenu
+-[@] &File

KE dit

Bifiemwy

Detbug
Fdow

][] [~
ele[e]e]

i}

Insert Menu Item

+ E EDevice

+ 6| &0 Insert Submenu Item
H E Dakta Rename

+-{@ | Displaty .

-8 | Thools Disable

+ E Bifindow Delete

+-| 6@ | &Help

Froperties -

Type |getD evicezFrom j

Browse. .

“ingtallDirlibfconvert/R ad2Grad. vee

Arguments

VisibleWhen  |natRunning j

Description

Edit here ta add description

Save E it

Another tool is CustomMenu Converter. Prior to version 9.0, only text file (.mnu file) was supported to customize the menus in the VEE
development environment. From Keysight VEE 9.0, XML file is also supported. We recommend to use XML file instead of text file. Although
text file is still supported in VEE 9.0, it will fade out in the near future. The CustomMenu Converter is used to assist you to convert your

old .mnu files to XML format (.xmnu files).
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CustomMenu Converter

Maote: WEE will ok remnowe minu files

C:%Program Files\AgilentWEE Pro 8.5\Excellibrany. mnu

Add

C:“Pragram F il=nt'YEE Pr M. ML

o
[

Remove

Femove All

!

Cormvert

Conversion succesad!
" C:AProgram Filez'AagilentVEE Pro 8 5%\Excellibrany. xminu

Conversion succesad!
* C:\Program Filez\AgilentVEE Pro 8.5\System. xmitu

See CustomMenu Editor and CustomMenu Converter for more information.

Error Call Stack

The Error Call Stack displays calling context(s) of the current Error. Use the Error Call Stack as an aid in debugging your VEE program. The
Error Call Stack displays the UserObject or UserFunction where the error occurs. In addition, the Error Call Stack also shows the list or
hierarchy of which UserObject or UserFunction is invoking or calling the currently executing object where the error occurs.

|0000; 3 UserFunction3)
0001: 2: UserFunction2()
0002; 1: UserFunction?()
0003: 0: Main(]

Cancel

You can get Error Call Stack information via Error pin or built-in function errorinfor(). See To View Error Call Stack for more detailed
information.

Examples ErrorInfo.vee , ErrorCallStack.vee .

Conditional Breakpoint

This feature provides you more flexible and powerful debugging capabilities.

Conditional Breakpoint equips you with the capability to set conditions and hit count for a breakpoint and specify what to do when a
breakpoint is hit, which gives you more control of the debugging process and higher efficiency.
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Breakpoint Condition

Condition

"When the breakpoint location is reached, the expression is evaluated and the
breakpaint iz hit only if the expression iz true.

v Conditior:

f

1 Hit Count

A breakpaint iz hit when the breakpaint location iz reached and the condition
iz zatizfied. The hit count iz the number of times the breakpaint has been hit.

Wwhen the breakpoint ig hit;
break. when the kit count iz equal to LJ ]1

Current hit count; I}

1 Specify what to do when the breakpaint is hit. -

| ™ Print a message:

J

¥ Continue execution

a. | Cancel

See Breakpoint Condition for more information.

Example HitCount.vee. More examples are located at " installdirectory/examples/Breakpoints/".

Breakpoints Window

The Breakpoints window allows you to explore and control all breakpoints in your VEE program. For example, you can activate or
deactivate breakpoints as well as delete breakpoints in the Breakpoints window.

Condition Hit Coint Wwhen Hit
| 5 conditicn] !
W w[n] [Formula) - M.7 [ho condition) break. always Break.
v 5 [Formula) - M.4 [hio condition) break. alwaps Break.
W JCT [unction] - M.12 [ho condition) break, alwaps Break

See Breakpoints Window for more information.

Integrated Database Support

You can integrate database operations into your instrument testing systems created with Keysight VEE. This feature allows you to easily
connect to any databases supported by ADO.NET, such as Microsoft Access, Microsoft SQL Server, Oracle, MySQL etc; you can store huge
amounts of testing data in that database with a well structured format, and then retrieve them at anytime as needed to do analysis or
testing.

Keysight VEE provides a set of menu commands to help you to integrate database operations into your VEE programs. Following figure
shows some of the commands.
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What is This Menu?

Quick Start {Short Cuts)

Initialize Database

QOpen Database

Connection Stake

Common SGL Command Generatar

Execute SCL Command

Fill Dataset

Dataset Navigation
Enurmerations in DataSek
Modify Rows in DataTable

Update Database

Show Data In DatadGrid
Show Data In DataGridyisw
Convert DataTable To Textarray

Convert DataRow To Texthrray

Aukomatically Generated Command

Filter Data
HULL
TF & == MULL

Close Database

Quit Database Library

Bytedrray To Image
Image To Bytefrray

Ltilities

Get Library Global variables
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See Overview of Database for more information.

Example InitializeMSAccess.vee. More examples are located at " installdirectory/examples/DatabaseLibrary”.

Miscellaneous

e Keysight VEE 9.0 adds support for NaN and +/-Infinity for data type Real64 and Real32 and introduces four built-in functions: isNaN,
isilfinity, isNegativelnfinity, isPositvielnfinity. VEE can convert NaN, Infinity from number to string and vice versa and allow NAN and
Infinity in .NET and MATLAB to output to VEE and vice versa. Refer to Support for NaN and INF for more information.

* New meaningful icons are used in the Program Explorer to improve its usability and make it consistent with other tool windows in VEE.

o Keysight VEE includes a multi-tabbed web browser allowing users to browse internet without leaving VEE. Besides the features of a
normal internet explorer, this browser also has all features of a tool window. It can be docked, hidden, and floated. See Web Browser
for more information on this web browser.

e Besides from menu File =>0pen, you can easily "Drag and Drop" a program to open it in VEE.

e Program Explorer will highlight the Main or the associated UserFunction automatically depending on where you are currently working
on.

* New Keysight VEE examples for some commonly used VEE objects are added to help you to easily kick start your learning.

Keysight VEE Pro 8.5 New Features

[}] Modern Integrated Development Environment (MIDE) -- The Integrated Development Environment in version 8.5 gives the user a
more modern and streamlined programming experience. This feature provides the user with additional functionalities and flexibilities
including the ability to customize the development environment to better meet their needs. With version 8.5, you can dock, float, hide,
move all your tool windows, such as Instrument Manager, Function & Object Browser, Program Explorer, Properties window, Watch
window, Output window, Minimap, Call Stack, Profiler, etc.

[Hl Microsoft Windows Vista Support--With Keysight VEE 8.5, you can take advantage of the latest Microsoft Operating System that is
more secure and easier to use. The Windows Aero interface, the Windows Instant Search, and the Windows Sidebar bring you a new
Microsoft Windows experience. The User Account Control (UAC) as well as other security related features will help maintain the health and
security of your PC.

[l per User Per Version VEE Configuration Files -- Starting from version 8.5, Keysight VEE saves configuration files with a per-user
and per-version style, to eliminate problems caused by configuration differences between versions and users.

[2] Microsoft Office 2007 Support -- Keysight VEE 8.5 supports Microsoft Office 2007 including the updated built-in Excel menu.

[}] MATLAB 2007a Support -- Keysight VEE Pro 8.5 upgrades the MATLAB support to MATLAB 2007a. The number of supported MATLAB
functions increases to 1800 with more than 1000 frequently used functions showing in FOB. Furthermore, you can easily choose the
MATLAB version to use under the MATLAB tab in the Default Preferences dialog.

[H color Coding -- This feature makes Keysight VEE programs easier to read by coloring different types of objects with different colors
automatically. Users can also color objects as they need and export/import the color theme to share with others.

[2] Uncertain Data Flow Compiler Warning -- Keysight VEE 8.5 gives a warning when potential compiler problem is found in an
Keysight VEE program. More information on the compiler warning is also provided in Keysight VEE online help.
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[}l Graphical Display Objects Enhancement -- In Keysight VEE 8.5, all graphical display objects, such as XY trace, Strip Chart, etc., can
display up to 255 traces.

[H Instrument Manager -- The Instrument Manager in version 8.5 is not only a tool window with brand-new UI which can dock, auto
hide, or float, but it also provides more convenient features, including context menu and toolbar, to find, add, remove, and configure
instruments and to create I/0 objects quickly. In the Instrument Manager, you can now double click an instrument or drag and drop an
instrument to the workspace to create an I/O object.

[}l using Keysight I0 Monitor to Monitor Instant Communications-- Keysight VEE 8.5 replaces the old Bus I/O Monitor object with
the Keysight IO Monitor, which is more powerful and easier to use.

[Hl Function & Object Browser (FOB) -- The newly designed Function & Object Browser allows you to easily browse and select functions
and objects available for use in your program. You can even double click or drag and drop an item in the member pane ( the top-right
pane) to quickly create an appropriate Formula object.

[}] output Window -- This feature helps you to debug your programs by logging Warning and Error messages during both run time and
design time.

] bynamically Change VISA Interface and Address -- With version 8.5, by changing the VISA interface and address
programmatically, you can communicate with the same instrument via different interfaces and addresses without extra configuration or
coding.

[l Exposing Main from Callable Server -- Users can now call the Main UserObject from programs written in other languages such as
C#, Visual Basic, C++, Excel Macro, and etc through the Callable Server interface.

[} Microsoft Standard File Open Dialog -- In Keysight VEE 8.5, the old file open dialog box, which appears when you use the To/From
File, To/From Dataset, or Import Library objects, is replaced by the standard Windows file open dialog box.

[l New Execution Mode and New Data Type --Beginning with version 8.5, Keysight VEE supports a new data type - UInt16 and new
Execution Mode - VEE 8.5.

VISA Change for ViReal32--Keysight VEE 8.5 supports ViReal32, ViReal32 [], and pViReal32 according to the latest VISA specification.

Keysight VEE Pro 8.0 New Features

Watch Window

Watch Window allows the user to view and edit values of variables and terminals when debugging. The program can continue execution
incorporating any changed values.

When you click @ button on Toolbar, or select View=" Watch Window, the Watch Window dialog box appears as follows.

toh Wincow
Locals G|Uba|SlWatch Terminals | Watch Y ariables

Mame Walue Type
i Declared Globals
t global_real <Uninitialized ¥V alue> Realtd Scalar
o Local to Library Decla
t localtoLib_real <Uninitialized ¥V alue> Realtd Scalar

Global and local ta library variables

See Watch Window for more information.
Examples

Datatype.veeTerminals.vee ,Globals.vee ,

Code Completion and Code Insight

Code Completion and Code Insight greatly benefits any user who writes formula objects by reducing keyboard inputs and the need for
memorization and external documentation. You can stay in your context, find the information you need, insert language elements directly
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into your formula, and even have Keysight VEE complete your typing for you. See Code Completion and Code Insight for more information.

Color Syntaxing

1. Comments are marked Green, Constant Strings are marked Dark Red and keywords are marked Blue.

2. Errors in a formula are marked by red wave lines.

3. Brackets are marked by grey frames.

Farmula

=
[

U This is a COMMERNT
"Thisis a COMST STRING"
AnErrorShouldBem arked.

1T E) +sgrt(h™h)-@a+h™c))

Result

Objects Supported by Code Completion and Code Insight

Objects Supported

Code .
Completion

e .NET objects

e Named VEE Objects
COM objects

e Built-in Constants

e Built-in Functions

e Records

Code Insight .

e Member functions of .NET and COM

objects
e Local UserFunctions
Imported UserFunctions
e Built-in Functions
e Imported Remote Functions
e Imported Compiled Functions

Programmatic Properties

Programmatic properties helps the user to create better GUI faster. It allows users to GET/SET properties of VEE Objects, .NET objects,
and COM objects at runtime. See ProgrammaticPropertyDemo.vee for a quick demo of this powerful new feature.

The following table shows properties that can be SET/GET programmatically. See To Change Properties Programmatically and To Change
Object's Name and Scope for more detail information

Example

ProgrammaticPropertyDemo.veeDemoTabIndexChangeDemo.vee

Minimap

Minimap is an outline map of the entire detail view with a red rectangle box indicating the visible portion. To open the Minimap, click @1
button on Toolbar or choose View = Minimap. An example of Minimap is shown in the following figure.
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The red rectangle shows the relative location of the visible area in the entire detail view. Just one click on the Minimap, you can quickly
jump to another location in the detail view. See Minimap for more detail information.

Home button

Keysight VEE 8.0 adds a new Toolbar button Home fal , which moves the upper left corner of a program to the upper left corner of the
context (Main, UserFunctions, or UserObjects).

New Execution Mode and Data Types

Beginning with version 8.0, Keysight VEE supports two new data types - Int64 and Boolean and a new Execution Mode - VEE 8.

Although the user can use TRUE and FALSE as constants since version 5.0, TRUE and False are not real Boolean constants. They are of
Int32 type. From Keysight VEE 8.0, the two constants will be of real Boolean type. The supported logical operations in Keysight VEE 8.0
are AND, OR, NOT, XOR, ==, and !=. Keysight VEE 8.0 also supports Boolean in Compiled Functions. The user can use VEE_BOOL as the
return type and the parameter type of a Complied Function. VEE_BOOL is treated as Boolean. See Boolean for more information.

New menu items and built-in functions added for Boolean:

e Data => Constant => Boolean

e Data => Constant => Boolean Array
e Data => Alloc Array => Boolean

e asBoolean(x)

Int64 has the longest precision for representing an integer. Keysight VEE provides two built-in numeric constants to represent the
maximum and minimum values of int64: MaxInt64 and MinInt64. Constants in different Execution Modes will be explained as different
types. See Int64 for more information.

New menu items and built-in functions added for Int64:

e Data => Constant => Int64

e Data => Constant => Int64 Array
e Data => Alloc Array => Int64

e asInt64(x)

Standardize on VISA Style Devices

Phase out older inconsistent I/0 devices (mixed SICL & VISA) for a more uniform approach (VISA) when declaring/using I/O devices.
Backward compatibility is maintained, even though users are "encouraged" to use new-style devices. See here for detail information.

Display Multiple Traces on Graph Objects through a Single Input Pin

This feature allows the user to display multiple traces (an array of traces) with the Keysight VEE Graph objects without knowing how many
traces there will be ahead of time.

A new Boolean Graph property is added called 'MatrixInput' in detail view properties. When this MatrixInput property is set to True, the
Keysight VEE Graph object would accept a 2D Array (up to 12 rows) as Input data and display multiple traces simultaneously. The Data
container comes into a graph on a single input pin. The graph figures how many traces are contained there (up to 12 rows), shows the
appropriate number of trace legends, and plots their points (columns). This new property CANNOT be toggled at runtime
programmatically. The user must know when they are building their Keysight VEE program whether they need this new-style graph.

For detail information, please see example program 2dXyTrace.vee, MatrixInputStripChart.vee.
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Multiple Transaction Enhancements
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In Keysight VEE 8.0, rich new features have been added for all transaction-based objects (e.g., Direct I/O objects, To/From objects),

especially supporting operations on multiple transactions.
Major enhancements include:

* Arbitrarily select, delete, copy, and paste multiple transactions

Sequencer

testa 0 ==
test6 0
testt 0 ==
= Double-Click to Add Transaction =

* Undo/Redo Add/ Insert/ Delete/ Cut/ Paste/ Edit/ Move up/ Move down actions

* All Windows-standard shortcuts

Add Trans...
Insert Trans...
Cuk Trans
Copy Trans
Seguer & Tran:
test! 0 == (5) == 1 Delete Trans
test? 0 == (5) 2=1 Move Trans Up
test30==(5) ==1 Move Trans Down
testd 0 == () <=1 Print Trans

testd 0 == {5) <=1

testd 0 == (5) <=1 Delete object

= Diouhle-Click to Add Transaction =

CTRL+X --- Cut the selected transaction(s) to the "cut-and-paste" buffer
CTRL+C --- Copy the selected transaction(s) to the "cut-and-paste" buffer
CTRL+V --- Paste transaction(s) at the pointer location

Delete --- Delete the selected item(s) in the list

Insert --- Insert a transaction before current selected item

CTRL+Z --- Undo last operation

CTRL+Y --- Redo last operation

CTRL+Up --- Move the selected transaction up (only for single-transaction)

CTRL+Down --- Move the selected transaction down (only for single-transaction)

CTRL+ LeftButtons --- Select multiple transactions

Insert
Chrl+3
ChrlC

Delete

Chrl+Hp

Record Usability Enhancement

Keysight VEE 8.0 enhances Record usability in three aspects:

1. Declare Variable now has a Generate context menu for Record data type. The user can generate Record Constant objects, Build Record

objects, and Unbuild Record objects.

Record Constant
Build Record
Unbuild Record

Delete object

2. Record Constant object now has a new Generate context menu for Record data type. The user can generate Declare Variable objects or

Unbuild Record objects.
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Declare Yariable
Unbuild Record

Delete object

3. Added a new Built-in Function: buildRecord (fieldNameTextArray, field1, field2, fieldN)

The user can use buildRecord() to build a record whose field names and values are not known until runtime. The first parameter is an array
of strings for the field names. The following parameters are values for each field, and the number of these parameters must match that
array length. buildRecord() returns a scalar record with the specified field names and field values. Two examples are as follows:

buildRecord(fieldNameList2Long, field1, field2);
builldRecord(fieldNamelList8Long, field1, field2, field3... field8);

See buildRecord() for more information.

NIDAQ Support Updated to Include NIDAQmx Drivers

Keysight VEE 8.0 provides support for new NI's Data Acquisition driver library NIDAQmx. This support includes access to all of the
functions in the library and online help for each function. Instruments Manager can find instruments with NIDAQmx drivers automatically.

Allow Scrolling in Panel View

ScrollBars can be set to automatically appear when your panel view is not large enough to display all objects. This feature can be turned
on and off by changing the Panel property named "ScrollbarsEnabled". The default is off. See here for detail information.

Instrument Samples
Added 16 new instrument samples in examples\instrumentIO\InstrumentManagerIntegrated.

Updated many Instrument samples.

Keysight VEE Pro 7.5 New Features

Programs saved from VEE Pro 7.0 or 7.5 will not load into prior VEE versions.

Excel Library Add-in
The Excel Library add-in offers simple connectivity between Microsoft Excel and VEE. No more dealing with the awkwardness of ActiveX.

The features you want from Excel are now completely exposed for your use using menu picks and options settings. For more information,
see Help=" How Do I =" Use the VEE Excel Library.
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For Each Statement

The For Each statement is similar to the For Count or For Range statements, but it executes the statement block for each element in an
array. It supports up to 10 dimensions. For more information, see For Each.
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NI Data Acquisition Support (PXI and PCI)

Support for NI's Data Acquisition driver libraries including NI-SWITCH, NI-DMM, NI-SCOPE, NI-DAQ, and NI-FGEN. This support includes
access to all of the functions in these libraries and online help for each function. See To/From NIDAQ.
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Cancel
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.NET Operation Builder

The .NET Operation Builder makes it very easy to select a .NET Type and subsequently build .NET operations by selecting the methods
and properties that are part of it. The operations are generated into a familiar transaction box similar to the existing To/From transaction
boxes. Start your tour of this new tool with .NET Operation Builder.

.NET Controls

The .NET Framework provides a rich set of standard controls in the System.Windows.Forms assembly. These controls are easily accessible
from VEE using the .NET Controls feature. Just select Device=" Windows Forms Controls and you see a listing of controls you can add to the
VEE work surface. Noted below is a partial listing.

i Agilent YEE Pro
System I/ Data

Display Excel ‘Window Help

Formula P 4w EE A KD %g

gl O i
Function & Object Browser  Ctrl+H
UserObject

MonthCalendar

UserFunckion

Impiort Lkicary Sun Mon Tue wed Thu Fri Sat
Delete Library 1z
Butkan
i 4 5 6 7 8 19
g CheckBox 0 11 12 13 14 15 18
wirtual Source 3 CheckedListEiox 17 18 19 20 H 22 23
Regression Combioio: M OX XX BTN
Chiinter ContainerCantral ;
Accumulakor DataGrid T Today: 4/29/2005
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- - Panel
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i S : PrintPreviewControl
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ProgressBar
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RichTextBox
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StatusBar
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TabPage
TexkBox
ToolBar
TrackBar
Treeview
WacrollBar

Load a Sample for a Selected Instrument

Select an instrument from the ones in Instrument Manager and choose Load sample. A list of available samples is presented. After you
select a sample, a new session of VEE is launched using the given instrument. The instrument is automatically configured, just press rRun
to see the sample in action.

Description Indicator
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It has been difficult to tell if an object had a description. If you choose to enable this indicator using befault Preferences, a small red
triangle appears in the upper right corner of objects that have a description.

= Ta/Fram NIDMM{NOT LIVE) =

= Double-Click to Add Function =

IVI-COM and Instrument Manager

IVI-COM is now a driver pick in the Instrument Manager. This makes it much simpler to configure and use IVI-COM drivers for your
instruments.

=& Initialize

=@ Close
+-EF plarm
+-E&H Calibration
+-B& Current
+-F& DAC
+-F5 Diagnostic
+-E& Digital
+-E Dizplay
+-E DriverOperation
< |

[
£

Createlnstance("Aailent.Agilent34970. nterop”',
“Aagilent Agilent34370 Interop. Agilent34970C ass" |

Create the IVI-COM driver.

QK | Cancel Help Member Help

Go To Panel on the Detail Context Menu

There has been an option in the Panel context menu called Go to Detail. This new feature adds a complementary context menu item for
the Detail menu called Go To Panel.

Keysight VEE Pro 7.0 New Features

Keysight VEE Pro 7.0 has some new features, such as the Property Grid and Microsoft Visual
Studio .NET programmability, that make the VEE Pro 7.0 save format unique. Programs saved from
VEE Pro 7.0 will not load into prior VEE versions.

Undo/Redo

One of the most commonly requested features has been Undo. Both Undo and Redo operations will be supported in VEE for many common
operations. Examples include: cut a line, delete a terminal, delete objects from a panel, paste objects, move an object, and many more.

| o] |78 %]

Undo Typing

See Undo and Redo

Object Property Editing

Using a property editing box similar to what is available in Visual Basic, VEE provides a Properties Window where you can easily change a
host of properties for your VEE objects. It's simple and, in most cases, will be two clicks and you're done. It works when you select
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multiple objects (providing an "intersection" of properties for the two objects if they are different). It works on the detail view and panel
view too!

Properties 3]
If/Then/Elze [If/Then/Else) - M.70 -
2% 41
E Appearance

BackColor [] Object
Font Object Test
ForeCalar Bl Ohject Text

ShowTeminal:  True
ShowTitleBar  True

Title 16/ Then/Elze
Titke BackColor [ 16/T hen/Else
Title Font Object Title Text
Tite ForeColor [l Object Title Text
El Behavior
BreakpointEnab Falze
E Design

Declared Mame

E lcon Appearance

lconPicture [rine]
ShowlconTile  True
Title

Tithe sting of the object

See Properties (Object)

Panel Edit Features

Editing objects on panels just got easier. The following have been added: a visible grid, alignment of objects, "rubber-band" selection of
objects, undo of many common operations while building a panel, bring to front, send to back, tab order, and other features as well.

Rich Text Format for Notepad and Description

Editing notes, and descriptions is now much easier. Using the power of .NET, RTF has been implemented for these two. Additionally, the
notes and descriptions contain automatic hyperlink detection and bring up a browser with the link you select. Both support undo (CTRL-Z)
and redo (CTRL-Y) as well as all your other familiar editing short-cut keys. You can cut and paste from an .rtf file directly into a note or
description and word wrap works also. Finally, you can create a custom template (default templates are templates\notepad.rtf and
templates\description.rtf). These templates are retrieved whenever you create a new object from the menu. Of course, if you don't want a
template, you can always remove it.

_.| Mote Pad | <

Topic: New Capabilities For Notepad Object
How to change default text?

This text 15 read from thus fle; <metalldir=Vtemplates\notepad.of.
This file can be modified with any editor capable of
readingwriting rf filez such as Wordpad or Microsoft Word.

Note: Select text, then right-click and select "Font and Color”
to change the colors and fonts of selected text.

Programmatically Use .NET Assemblies

There are a great number of .NET classes available today, and there will be more in the future. Sometimes the functionality these classes
provide is not available in VEE or is more desirable than what VEE offers. To make these valuable assets available to you, VEE 7.0 provides
access to the Microsoft .NET Framework Library. This Library contains feature rich classes that you can use in a way similar to your use of
ActiveX in VEE 5.x and above. See the examples in the DotNet examples directory to get some idea of the power of the .NET Framework
to enhance VEE.

An additional feature is the ability to import namespaces. From the Device > .NET Assembly References menu, check the "Import
namespaces after closing" checkbox. Choose one or more .NET Assemblies, and you will be prompted to select zero or more namespaces.
You can also choose Import .NET Namespaces from the Device menu. What is the significance of this? Well, without a namespace import
you might have to type System.IO.File.Exists(). With a namespace import, your method call looks like File.Exists(). Just a few clicks
replaces a lot of typing.
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A new type conversion function called asClrType has been added. This function converts a VEE data type to a .NET/CLR data type. The
valid .NET/CLR data types include all of the primitive data types (Boolean, Byte, SByte, Int16, Int32, Uint32, Int64, Char, Double and
Single), Decimal, DataTime, and String. asClrType is rarely needed as VEE converts between VEE and .NET data types automatically most
of the time. For an example of VEE program using asCIrType, please see examples\dotnet\datetime.vee.

See Tell Me About > .NET Framework in the Table of Contents

Connectivity for USB Based Instruments

Keeping VEE current with the newest Keysight instrumentation and competitive software products has always been a goal for Keysight. To
this end, the I/O subsystem has been enhanced to accommodate instruments with a Universal Serial Bus (USB). Another feature of USB
support is the ability to use USB aliases. USB aliases replace the long and awkward address string of USB addresses.

Connectivity for LAN Based Instruments

As stated in the USB connectivity paragraph, alternative connections to instrumentation are becoming standard. To adapt to these
changes, VEE has been enhanced to provide connectivity for LAN-based instruments.

Use IVI-COM Drivers

IVI-COM is the latest standard for instrument compatibility. Established by the IVI Foundation, it encourages instrument manufacturers to
produce instruments that are interchangeable with their competitors. To adapt to these new standards, VEE will accept all Keysight IVI-
COM drivers and some third party IVI-COM drivers as well.

VEE interacts with IVI-COM drivers by finding a Primary Interop Assembly (PIA) for them. An assembly is an .EXE or DLL file and is the
fundamental building block of a .NET application. The PIA is a .NET assembly that is provided by vendors for their COM based components.
Since your IVI-COM driver is a COM based component, VEE will attempt to find a PIA for it. Once this is done, VEE lets you use the IVI-
COM driver just like any other .NET assembly.

See What is IVI?

The Error Reporting Mechanism has Changed

Keysight has changed the VEE error reporting mechanism. Please take advantage of this valuable facility. See Minidumps for
more information.

What’'s New in Keysight VEE 6.0

Welcome to the Keysight VEE software family, version 6.0. A list of new features and enhancements for version 6.0 follows. For more
information about these features click "New Features" or "Enhancements." For more information about all the features in your Keysight
VEE software, see the Help Contents or Index.

New Features

Multimedia Tutorials

Integrated MATLAB® Script

Callable VEE ActiveX Automation Server
New Data Types

VEE 6 Execution Mode

New Functions

VEE I/O Configuration File Saved with Program
Programmable Instrument Properties
Dynamic I/O Automation Server

Added I/0 Diagnostics Features
Instrument Manager Toolbar Button

VXI 64-bit Memory Access Support

PC Plug-In Card Support

Added Program Explorer Submenu

New RunTime Option

Program Settings Stored in Registry
MAPI Email Support

Microsoft Intellimouse Wheel Support

Keysight VEE (on Windows) now includes multimedia tutorials to help you become productive even
faster. Here are the easy viewing steps:

1. Put the VEE CD in the same CD drive you used when you installed VEE.

2. Run VEE and click the "Tutorials" button in the Welcome Window.
3. Watch any or all of the seven helpful tutorials.
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Integrated MATLAB® Script

Keysight VEE 6.0 makes the power of MATLAB available to the VEE programmer. VEE now ships with a runtime version of MATLAB Script.
There is also a new MATLAB Script object in the Device menu. All available MATLAB functions are displayed in VEE's Function & Object
Browser also. (VEE does not provide MATLAB support on HP-UX.)

Callable VEE ActiveX Automation Server

Previous versions of VEE provided two ways to execute VEE code from other development environments: the C-to-VEE API and the Callable
VEE ActiveX Control. Keysight VEE Pro 6.0 replaces the old ActiveX Control with an ActiveX Automation Server that allows you to easily
access VEE code from programming environments like Visual Basic. (The Callable VEE Server is supported on Windows only.)

For more information, refer to the VEE CallServer Help.

New Data Types

UInt8, Int16, Real32, and Variant are new data types for Keysight VEE 6.0. All new data types appear in all Execution Modes, as well as
new transactions such as WRITE TEXT INT16. However, new transactions behave the old way in old modes. For example, in VEE 5 mode,
WRITE BINARY INT16 actually does a WRITE BINARY INT32 and will not convert the data to an Int16. In VEE 6 mode, WRITE BINARY
INT16 does convert data to an Int16. See the Execution Mode topic for ways that VEE Execution Mode could change program behavior.

Locations

Data = Constant = UInt8
Data = Constant = Intlé6
Data = Constant = Real32
Data = Allocate Array = UInt8
Data = Allocate Array — Intlé6
Data = Allocate Array — Real32

VEE 6 Execution Mode

Version 6.0 of Keysight VEE software adds a VEE 6 Execution Mode to the Default Preferences Dialog Box. For more information, see the
Execution Mode help topic.

New Functions

VEE's new data types (Int16, Real32, Variant, UInt8) help expand compatibility with ActiveX automation servers. Also, new functions make
it easier to deal with other ActiveX data types that have no VEE counterpart (for example, Currency and Date). For details, see the Type
Conversion help topic. The following new functions were added to the Keysight VEE 6.0 language.

asVariant ()
asVariantBool ()
asVariantCurrency ()
asVariantDate ()
asVariantError ()
asVariantEmpty ()
asVariantNull ()
baseName (pathStr)
commandLine ()
dirName (pathStr)
inDaylightSavings ()
isVariant ()
isVariantBool ()
isVariantCurrency ()
isVariantDate ()
isVariantError ()
isVariantEmpty ()
isVariantNull ()
programName ()
typeName (x)

VEE I/0 Configuration File Saved with Program

VEE 6.0 allows you to embed I/O configuration information in the program itself, rather than using the veeio resource file. To enable
embedding of the configuration information, a Save I/O configuration with program check box has been added to the Save File Dialog Box.
See Instrument Manager for more information on saving an I/O configuration.

Location: File Save (Save a new program)
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File Save As (Save As)

Programmable Instrument Properties

Version 6.0 of Keysight VEE software adds the capability to change instrument parameters (such as timeout value) at runtime. This new
feature obsoletes control inputs to the Direct I/O Object and allows you to Get/Set some programmatic instrument parameters at runtime.
(Although the need for control inputs is eliminated, control inputs are still supported.) Available instruments and their properties are
listed in the Function and Object Browser, and formulas can be created from this list.

For information on available properties, see GPIB Instrument Properties , GPIO Instrument Properties , Serial Instrument Properties , and
VXI Instrument Properties . Also see these two examples:

examples\InstrumentIO\ProgrammablelnstrPropertyl.vee

examples\InstrumentIO\ProgrammablelnstrProperty2.vee

Dynamic I/0 Automation Server

In previous versions of VEE, instrument bus addresses in the VEE 1/O configuration file were static (fixed). For version 6.0, the Dynamic
I/0 Automation Server lets you find and identify instruments programmatically. This provides new levels of flexibility. For example, you
can find all your instruments and then use Programmable Instrument Properties to set up Direct I/O objects. (The Dynamic I/O
Automation Server is supported on Windows only.)

See Dynamic I/O Automation Server for more information.

Added I/0 Diagnostics Features

Version 6.0 adds significant new I/O diagnostics features. These features can be divided into error prevention and error recovery, primarily
involving instrument checking.

Error Prevention

VEE 6.0 can perform instrument checking before the VEE program body executes. To enable instrument checking, use File Default
Preferences and select the Check Instrument Addresses at PreRun box. For more information, see Default Preferences (the "Debug"
group).

Error Recovery

Version 6.0 adds a Troubleshooting button to the VEE Run Time Error Dialog box when an I/O timeout error is detected. The diagnostic I/O
errors caught are Error 811 - Timeout or General I/O Error.

When a VEE instrument access has failed because of a non-existent interface or unoccupied bus address, the diagnostic indicates the type
of error and provides some suggestions to correct the error.

Instrument Manager Toolbar Button

Version 6.0 adds an Instrument Manager icon to the Toolbar display for easy access to the Instrument Manager Dialog Box. You can, of
course, still access Instrument Manager from the menu using I/O Instrument Manager....

VXI 64-bit Memory Access Support

Keysight I/0O Libraries G.02.02 supports 64-bit access to some VXI instruments’ memory space. This feature enables VEE programs to
read/write memory in 64-bit units. If you have version G.02.02 (or greater) installed, you can use the A24/A32 Space tab on the Advanced
Instrument Properties dialog box to enable this access mode.

Location: I/O Instrument Manager

(Select a VXI instrument) Instrument Properties Advanced... A24/A32 Space tab.

PC Plug-In Card Support

VEE 6.0 supports PC Plug-In cards with ODAA (Open Data Acquisition Association) compliant software drivers. To use these cards, install
the hardware and software, then configure subsystems according to the manufacturer’s instructions. From the Keysight VEE Instrument
Manager, click the Find Instruments button.

If the PC Plug-In cards are configured correctly, the Instrument Manager displays the configured subsystems. Select the desired
subsystem, then click the PCPI Driver button to create a formula object. You can browse properties and methods, and can create a formula
from the Function & Object Browser dialog box for the subsystems.

Added Program Explorer Submenu
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In Keysight VEE 6.0, a new submenu was added for Globals in the Program Explorer. This new choice, named "Generate," provides
convenient access to operations involving the Global Variable, such as Get, Set, and If/Then/Else.

New RunTime Option

The VEE Pro RunTime has a new option -enablewarnings that allows you to check your program under RunTime to make sure that you
have all the necessary files. Without -enablewarnings, the RunTime product silently ignores non-fatal errors like "Picture file is missing."

Program Settings Stored in Registry

In VEE 4.x and 5.0, certain information (such as Toolbar visible, Status bar visible, etc.) was saved in the default preferences file (vee.rc).
With version 6.0, these settings are no longer stored in the vee.rc file.

In addition, previous versions of VEE on Windows stored some settings in the v.ini file. VEE no longer uses a v.ini file on MS Windows. All
these settings are now stored in the Windows registry on a per user basis under HKEY_CURRENT_USER\Software\Keysight\VEE.

On HP-UX, the information is stored in a file called .vee-settings and is located in the user’s $HOME directory. (That file was previously
called .vee-history.)

You do not have to do anything to store the program settings, as the settings are stored automatically when VEE exits. The next time you
open VEE, it appears in the same place, with the same size, and has the same user interface options selected.

MAPI Email Support

Version 6.0 adds a "Send Program by Email" File menu item for systems that have a MAPI profile. For HP-UX systems and PCs without a
MAPI profile, this feature is not supported.

Location: File Send Program by Email

Microsoft Intellimouse Wheel Support

Version 6.0 adds support for the Microsoft Intellimouse. If you have a Microsoft Intellimouse or a compatible clone, rotating the mouse
wheel while a list view has focus causes the list view to scroll up or down.

Enhancements

Improved Install Program

Variant to VEE Data Type Conversion — Improved Array Handling
Improved Automation Server Cleanup
Additional Graphics File Support
Improved XY Marker Properties
Smarter Creation of Transaction Pins
Get and Set Formula Buttons
Updated Functions

Improved PC Execute Object
Instrument Manager Update
Convenient Object Resizing

Additional Keyboard Shortcuts
Improved Sequence Line Color
Configuration Save Options

Improved Install Program

The new Windows install program allows you to do several things you couldn’t do with the old VEE install program. After you have
installed VEE, you can run the Control Panel applet "Add/Remove Program" and select Keysight VEE. You will notice some new
functionality. Not only can you Remove Keysight VEE, you can also Modify an existing installation. This allows you to install a component
you originally did not install, such as Non-HP Panel Drivers. You can also remove a component that is no longer being used. The Repair
option allows you to repair your installation of Keysight VEE.

Variant to VEE Data Type Conversion - Improved Array Handling

When data are returned from an ActiveX Automation Server (such as Excel) or an ActiveX control, VEE must convert the automation data
types to VEE data types. With VEE 5.0, an array of Variants converted into a VEE Record. With version 6.0 (in VEE 6 Execution Mode), an
array of Variants is converted into a VEE array if all elements are of the same data type. (For mixed data types, there is no change from
VEE 5.0 behavior.)

If all elements of the source Safearray of Variant are of the same data type, mapping of Variant data type to VEE array data type is as
follows. (Note: this feature is available in VEE 6 Execution Mode only.)

Variant array member type VEE 6.0 data type
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VT_UI1 UInt8
VT_BOOL Int32
VT_I2 Intl6
VT_UI2 Int16
VT_I4 Int32
VT_UI4 Int32
VT_R4 Real32
VT_R8 Real64
VT_DATE Real64
VT_CY Real64
VT_BSTR Text
VT_DISPATCH Object

Improved Automation Server Cleanup

You may have noticed that when your VEE program finished, and it used an Automation Server (like Excel), sometimes the Excel (or
whatever) application did not quit. VEE 6.0 has improved handling of ActiveX references and releases all unneeded pointers. For more
information about programming techniques that affect the cleanup of ActiveX references, see the CreateObject topic.

Additional Graphics File Support

Version 6.0 adds read-only capability for JPG, WMF, and PNG formats on Windows 95/98/NT. More BMP and GIF formats can be read also.
Refer to the Picture object help topic.

Improved XY Marker Properties

Version 6.0 allows you to get the position of Markers as values in any expression. For details about these new properties, refer to the
section titled "Programmatically Setting and Reading Marker Values" in the Help topic for any XY Display. Some examples of XY Displays
are XY Trace, Magnitude Spectrum, and Polar Plot. Also see the topic: To Get and Set Marker Properties.

Smarter Creation of Transaction Pins

Objects with Transactions now automatically add inputs and outputs based on the use of terminal names in the transaction. This feature is
aware of local or global variables, so pins are not added when the name refers to a local or global variable.

Get and Set Formula Buttons

The Function & Object Browser now supports creating two types of formulas for properties in the ActiveX, VEE Objects, and Instruments
groups. You can create a "Get Property" formula or a "Set Property" formula by pressing the appropriate button.

Updated Functions
The following functions have been updated for Keysight VEE software version 6.0.
whichOS() Added Windows 98 and Windows 2000.

createObject() Added an optional hostname parameter.

Improved PC Execute Object

The PC Execute object now supports returning an exit code from the executed program and can use a registered suffix to run associated
programs. See the Execute Program (PC) Help topic.

Instrument Manager Update

Version 6.0 makes it easier to configure instrument drivers by providing a "Configure Drivers" button in the Instrument Manager dialog
box. You can select a single instrument, an interface card, or the entire I/O configuration and configure the driver(s) with one button click.
For more information, see the Instrument Manager Help topic.

Convenient Object Resizing

In Keysight VEE 6.0, any object can be resized by dragging any one of its four corners. This convenience works in the panel view or the
detail view.

Object Resize operations now snap-to-grid by default. The behavior is the same in Panel View and in Detail View. Grabbing a corner with

an unshifted mouse click starts coarse (snap-to-grid) resizing. Grabbing a corner with a shifted mouse click starts fine (1-pixel) resizing.
The grid size is fixed at 10 pixels in Detail View and defaults to 10 pixels in Panel View.
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In VEE 5.0, snap-to-grid was the only behavior in Panel View, and fine resizing was the only behavior in Detail View.

Additional Keyboard Shortcuts

There are some new mappings for function keys to aid in debugging:
F5 maps to "Run" as does Ctrl-G

F10 maps to "Step Over"

F11 maps to "Step Into"

Shift-F11 maps to "Step Out"

See Using Keyboard Shortcuts for a complete list of VEE shortcut mappings.

Improved Sequence Line Color

In Keysight VEE 6.0, all lines connected to a sequence input are one-pixel wide and light gray, which allows lines that are actually carrying
program data to stand out. (A majority of VEE program lines typically designate sequence, not data.)

Configuration Save Options

In Keysight VEE 6.0, "Save colors/fonts with program" and "Save Device Configuration" have been removed from the "Default Preferences"
dialog box, and the following options have been added to the "Save File" dialog box:

Options

[ ] Save colors and fonts with program

[ 1 Save I/O configuration with program

See Save As for more information about using the save options.

Location: File Save As...

What is New in HP VEE 5.0

Thank you for using HP VEE. Many features in this version are new or have changed from previous versions, and this section of HP VEE
Help describes them for you. Scroll through the topics below for a summary of what's new, and an introduction to compatibility issues with
your existing programs. Click on the links to get more information about using these features. For detailed information about these and all
other existing features in HP VEE, see the HP VEE Help Contents or Index.

The HP VEE Web site contains support information, instructions for downloading instrument drivers, and many other helpful resources.
You can link to our site from the HP VEE window using Help => HP VEE on the Web.

Note: The save file format changed after HP VEE 3.x. If you save your HP VEE 3.x program in HP VEE 4.0 and later, you will not be able to
open it in HP VEE 3.x and earlier.

The save file format remained the same from HP VEE 4.x to HP VEE 5.0. However, your programs may not run correctly if you move them
between the two versions. For example, if you open your HP VEE 4.x program in HP VEE 5.0 to use new features, then save the program,
you can open it again in HP VEE 4.x. However, the new features will be removed, and may corrupt the program.

ActiveX Support HP VEE for Windows supports ActiveX automation and controls on PCs running Windows® 95/NT® 4.0 or greater (not
supported on UNIX).

ActiveX automation lets you use HP VEE as an Automation Controller. This lets you control other applications such as Microsoft® Word,
Excel, and Access for activities such as sending data to the applications for report generation. This fully supersedes our current application
control solution, Dynamic Data Exchange (DDE), for automation-capable applications.

ActiveX controls, available from various vendors, extend HP VEE's functionality by providing domain-specific services via ActiveX
automation properties, methods and events. Most ActiveX controls also provide a user interface that let you manipulate a control such as a
Calendar to initiate events based on calendar dates.

Web Monitoring HP VEE includes a built-in Web server letting you monitor and troubleshoot an HP VEE application from a remote Web
browser using standard HTTP protocol. You can use this feature to

e Troubleshoot a system running on the factory floor.
e Retrieve information from an HP VEE program.
e Monitor a test system.

HP VEE Objects and Functions
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XY Displays contain several enhancements that let you define scale labels and their spacing, and set number formats.

Knob, Slider and Indicator Objects contain enhancements that let you select logarithmic or linear scaling, set number formats, and control
tic mark labels and their spacing.

Formula Object now accepts expressions in multiple lines. When you enter one or more expressions, you can have one expression per line,
or split the expression(s) over multiple lines.

UserFunction Menu choices let you automatically generate calls to UserFunctions from the objects and functions most frequently used for
calling UserFunctions: Call, Formula, If/Then/Else, showPanel(), and hidePanel().

SavePanelImage Function allows programmatic rendering of an HP VEE UserFunction panel to a file letting you dynamically embed an
HP VEE panel in a report.

Development Environment

The HP VEE Development Environment contains several changes including

e Execution Mode has changed to Compatibility Mode in the Default Preferences dialog box; modes are VEE 3, VEE 4, and Standard.
e Select Function dialog box is now Function & Object Browser (Device menu). It is Function Browser on UNIX.

e Expanded Clipboard support lets you copy object bitmaps from HP VEE to other Windows applications

e .vxe binary file format for smaller files and better security for RunTime programs.

e Better access to online Help information.

Instrument Manager

The button labels on the Instrument Manager dialog box have been changed. The Configuration areas button labels will change
dynamically depending on which node is selected in the Instrument List tree view. This gives better information about configuration
changes allowed for each node. For more information, see Instrument Manager .

ActiveX Support
HP VEE for Windows supports ActiveX automation and controls on PCs running Windows 95/NT 4.0 or greater (not supported on UNIX).

Note: To enable ActiveX support, HP VEE must be set to Standard mode in the Default Preferences dialog box on the General tab. This is
the default mode for new programs. See the "Execution Mode" section in Development Environment for details about changes to menus,
objects, and functions when HP VEE is set to Standard mode.

ActiveX Automation lets you use HP VEE as an Automation Controller. This lets you control other applications such as Microsoft Word,
Excel, and Access for activities such as sending data to the applications for report generation. This fully supersedes our current application
control solution, Dynamic Data Exchange (DDE), for automation-capable applications.

ActiveX Controls, available from various vendors, extend HP VEE's functionality by providing domain-specific services via ActiveX
automation properties, methods and events. Most ActiveX controls also provide a user interface that let you manipulate a control such as a
Calendar to initiate events based on calendar dates.

Recommended Reading

Microsoft Office 97 Visual Basic Programmer's Guide
Microsoft Press, 1997
ISBN 1-57231-340-4

HP VEE implements its ActiveX support using the standard established by Microsoft Visual Basic. If you are unfamiliar with ActiveX
technology, review the chapters in this book that discuss Object Models, and ActiveX Controls. Understanding these concepts will help you
use HP VEE's ActiveX features.

Read the chapter "Using ActiveX Automation Objects and Controls" in the HP VEE Advanced Programming Techniques manual to learn how
to use ActiveX in HP VEE. Many new example programs have been added to the \examples directory. To open them from the HP VEE
window, use Help => Open Example. They are under \ActiveXAutomation and \ActiveXControls.

Web Monitoring

HP VEE includes a built-in Web server letting you monitor and troubleshoot an HP VEE application from a remote Web browser using
standard HTTP protocol. You can use this feature to

e Troubleshoot a system running on the factory floor.
e Retrieve information from an HP VEE program.
e Monitor a test system.

You can enable the Web server by using the new Web Server tab on the Default Preferences dialog box. For this feature to work, HP VEE
must be running on a system that is connected to a network. To remotely monitor the program from a Web browser, you must know the
system's host name. For detailed information see Default Preferences.
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HP VEE Objects and Functions

XY Displays contain several enhancements that let you define scale labels and their spacing, and set number formats. These changes
appear in their Properties dialog boxes. Here is a summary of the changes. For details, see the Help topic for any display object such as XY
Trace. Each display may contain some variations to support its configuration.

e You can set the XY display background color of an individual display object in the Properties dialog box on the Colors tab. Changing
the color in the Display area of the tab overrides the default color set in Default Preferences.

e Information about traces and scales has changed on the display object's open view. The editable fields for traces and scales have
changed to flat buttons. The scales' major tic marks are now labeled, and the min/max values cannot be edited on the open view.

To edit properties, click on a trace or scale name on the open view to pop up an Edit dialog box. Or, double-click the object's title bar to
use the Properties dialog box; you'll notice that Traces and Scales button is gone from the General tab, and there are two new tabs, Traces
and Scales.

Traces properties have not changed from HP VEE 4.x.

Scales properties have changed. Now, you can edit the min/max values only with the other properties, and two more properties are
available - Label Spacing and Automatic Scaling. The properties for each scale (including the additional right scales) can be set individually.

To set the label spacing on major tic marks, click on the down-arrow by Label Spacing and click on your choice. For new programs, the
default setting for X scale is Every Major Tic, and Every Other Tic for Y-Main scale. For older programs, the default is Only Max & Min to
maintain a similar appearance to older style display objects.

You can set the label font separate from the object font in the display object Properties dialog box in the Fonts tab. Changing the font in
the Scale Label area of the tab overrides the default font set in Default Preferences. The label color tracks the object text color set in
Default Preferences or in the object Properties dialog boxes.

Autoscale properties have changed, and now includes an Automatic Scaling mode. The Auto Scale button on the open view is optional. You
can show or hide the button in the Properties dialog box, on the General tab, in the Layout area. You can set the Automatic Scaling mode
while setting other properties for the X and Y-Main scales. When Automatic Scaling is On, the scale automatically "auto scales" to incoming
data. Additional right scales (Y2 and Y3) track Y-Main. This mode is not supported for the Strip Chart.

For older programs with existing display objects, Automatic Scaling is Off and the Auto Scale button appears in the open view to maintain
a similar appearance to older style display objects. New display objects added to older programs use the default setting: both X and
Y-Main set with Automatic Scaling mode On, and no Auto Scale button.

The control inputs for Auto Scale X, Auto Scale Y, and Auto Scale remain unchanged. The Scales control input record now accepts a new
text field named AutoScale that accepts the values On or Off. This allows programmatic access to the Automatic Scaling. This is not
supported for the Strip Chart.

e You can set the number format for each scale in the Properties dialog box on the Number tab.

The Marker values use the same number format as the scale to which they are attached. The Delta Markers for the X and Y scales use the
default number format set in the Default Preferences dialog box. However, if both Markerl and Marker2 on the X or Y scales are using
Time Stamp format, the Delta Marker uses Delta Time format.

e The Layout area on the General tab of the Properties dialog box has changed. The new options give you greater flexibility for
controlling the open view's appearance and security:
e Show Traces Legend turns the Trace edit buttons on and off.
e Show Scales Legend turns the X and Y scale edit buttons on and off.
e Show Scale Labels turns the axis scale labels on and off.
e Show Scroll Bars turns the scroll bars on and off.
e Show Auto Scale Button turns the Auto Scale button on and off.
¢ Enable Trace/Scale Editing controls the edit function of the Trace and Scales edit buttons.

Knob, Slider and Indicator Objects

Contain enhancements that let you select logarithmic or linear scaling, set number formats, and control tic mark labels and their spacing.
These enhancements specifically affect the Integer/Real Knob and Slider, Meter, Thermometer, Fill Bar and Tank objects. The Color Alarm
adds only the number format control. All of these changes appear in the Properties dialog box for each object.

e You can choose between linear and logarithmic scaling on the General tab, in the Scale area. Logarithmic scaling is not supported
for the Integer Knob/Slider objects.

e You can set the label spacing for major tic marks on the General tab in the Scales area. Click on the down-arrow by Label Spacing
and click on your choice.

e You can turn tic marks and labels on and off in the Knob, Thermometer, Fill Bar and Tank objects. This was allowed previously only
in the Slider and Meter objects.

e A Number formats tab has been added to the Thermometer, Fill Bar, Tank, and Color Alarm Properties dialog box. Now, these

objects, like the Knob, Slider, and Meter, will display their min/max and tic label values in the current number format.

For detailed information see Integer KnobInteger_Knob, Integer SliderInteger_Slid, Real KnobReal_Knob, Real SliderReal_Slider, Fill

BarFill_Bar, MeterMeter, TankTank, ThermometerThermo.

Formula Object now accepts expressions in multiple lines. This lets you expand the Formula object vertically and horizontally when
entering long expressions. Formula objects in older programs opened in this HP VEE version will follow this new behavior. When you enter
one or more expressions, you can have one expression per line, or split a single expression(s) over multiple lines as shown in the following
example.
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(a == somelLongExpr
? "return somelLongTrue"

: "return somelLongFalse"

e A carriage return (\r) is added as the separator at the end of each line; it is not visible. The parser checks for a valid expression
when the Formula object loses focus. In the next two examples, the first expression causes a syntax error because it appears that a
variable name has been split. The resulting error message points to the error location:

2*A+

3 - foo

bar - snafu

The next example fixes the problem by adding an operator after foo:
2*A+

3 - foo -

bar - snafu

e Control inputs to a Formula object now accept Array or Scalar Text.
e Editing Features have been added to Formula so you can edit multiple lines of expressions more easily.
e For detailed information see FormulaFormula_Object>main.

On the UserFunction Menu, the Generate menu pick cascades to include more choices to let you automatically generate calls to
UserFunctions from the objects and functions most frequently used for calling UserFunctions: Call, Formula, If/Then/Else, showPanel(), and
hidePanel(). Previously, only the Call object was automatically generated. The additional menu picks let you generate calls to
UserFunctions from more appropriate objects, such as referencing a Boolean function with an If/Then/Else object, or controlling your
program's appearance using the showPanel() or hidePanel() function. Access to the Generate menu pick remains the same.

e In the Program Explorer, click the right mouse button on a UserFunction name.
e In a UserFunction window, use the object menu.
e For detailed information see UserFunctionUser_Function>main.

The savePanellmage() Function allows programmatic rendering of an HP VEE UserFunction panel to a file. This lets you dynamically
embed an HP VEE UserFunction panel in a report. UserObject panels are not supported. The savePanellmage() (Device => Function &
Object Browser) is located with the Built-in Functions in the Panel Category. A Formula object performs the function call. Graphics formats
supported by savePanellmage() include Windows Bitmap (Windows only) and JPEG (Windows and UNIX). For detailed information, see
savePanellmage().

Development Environment

Execution Mode has changed to Compatibility Mode in the Default Preferences dialog box on the General tab. Supported modes are
Standard, VEE 4, VEE 3. Also, the Disable Debug Features checkbox moved to the Debug area. The VEE 4 and VEE 3 modes retain their
compatibility definitions set in HP VEE 4.x. There are minor changes, described below, that will not affect your existing programs if you
continue running them in their original modes.

The new Standard mode is a superset of the VEE 4 mode and introduces some significant changes affecting program compatibility. Most of
the changes enable the new ActiveX automation features, and they may impact your programming techniques if you use any of the
features described below - even if you do not use ActiveX. For information about ActiveX automation and controls, see ActiveX Support.

New HP VEE 5.0 programs will open in Standard mode. Older programs must be changed manually to the new mode, if desired, in Default
Preferences. When you change a program to Standard mode, errors can occur, and a list appears of things that are no longer allowed. You
need to fix these before HP VEE accepts the switch to Standard mode. HP VEE does not automatically revise any part of your program to
fix the errors. A summary of the Standard mode compatibility changes are described below that will help you fix errors.

Note: For detailed information about Compatibility Mode, you are encouraged to read the appendix "Using the Compatibility Mode" in the
HP VEE Advanced Programming Techniques manual. If you want to change HP VEE 3.x programs to Standard mode, you should be sure
they work in VEE 4 mode first, then change them to Standard mode.

Changes for Standard mode include:

e HP VEE programs are compiled.
e In the Formula object:
e SET and ByRef are new keywords used for ActiveX automation, and cannot be used as names for terminals.
¢ New syntax is supported for ActiveX automation such as excel.worksheets(1).cells(1,2) = 2.
e Entering array syntax without commas, such as [1 2 3] will cause an error when Formula loses focus.
e A value such as 1 returns an Integer, 1.0 returns a Real. Previously, both returned a Real.
e There are two new built-in functions for ActiveX automation: CreateObject() and GetObject().
e When Delete Variables at PreRun is turned on (in Default Preferences) global variables are not deleted if they reference ActiveX
controls.
e The Declare Variable object has a new variable type called Object for ActiveX automation.
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The new Object variable type is also available on Input Terminals as a Required Type, though it can't be coerced.

The Device menu contains new menu items: ActiveX Automation References..., ActiveX Control References..., and ActiveX Controls.

Global nhamespace rules have changed:

e Local UserFunctions, Library names, global declared and undeclared variables, and local to library declared variables are all in
the same namespace, and must have unique names. So you can't have a UserFunction and a declared global variable with
the same name.

e In a Library, local UserFunctions and local-to-library declared variables are in the same namespace and must have unique
names.

e READ TEXT transactions in objects such as To String and From String have changed how the read pointer behaves when using the
TOKEN format with EXCLUDE CHARS. Now, after a READ TEXT transaction, the pointer advances to the next non-excluded
character, ready for the next transaction. In VEE 3 and VEE 4 mode, the pointer stops at the excluded character.

e In VEE 3 and VEE 4 modes, a program using a To File or From File object with the EXECUTE REWIND transaction to access the same

data file as a To DataSet or From DataSet object causes unexpected interactions, where data can be written incorrectly. In Standard

mode, this unexpected interaction is fixed so the data is written to the file correctly.

Changes for all modes include:

e When older programs are opened, they will be in VEE 3 or VEE 4 mode depending on how they were saved. Expressions with array
syntax, such as [1 2 3] (without commas) will be reparsed when the program loads and automatically modified to use commas.
e New syntax is allowed in the Formula object, such as lib.func(a,b) = RightHandExpr

This parses correctly in all modes, and executes correctly only in Standard mode (errors at run time in VEE 4 and VEE 3). This lets you fix
global namespace problems with imported libraries when changing modes.

e UNIX programs can be put into Standard mode. This affects the global namespace as described above. However, the ActiveX menu
items will not appear since they are not supported on UNIX. A program that calls HP VEE functions supporting ActiveX, such as
CreateObject(), will error. Standard-mode programs with declared Object variable types will load into UNIX, but they will not run
properly.

Select Function

This dialog box is renamed to Function & Object Browser (Device menu) to include ActiveX automation and controls support with the
existing math operators and functions. On UNIX, it is Function Browser. For more information see Function and Object Browser , and
"Using ActiveX Objects and Controls" in HP VEE Advanced Programming Techniques.

Expanded Clipboard support

Lets you cut/copy/paste objects from HP VEE to other Windows applications that support bitmap rendering. This is in addition to the
current support letting you cut/copy/paste objects only within and between HP VEE sessions. Select one or more objects you want to cut or
copy, then use the HP VEE Edit menu or the toolbar to render the object(s) into the Clipboard. The Copy menu item has also been added
to the UserObject and UserFunction object menu.

Greater RunTime program security

This is available for .vxe files. You can now save a RunTime version of your program in binary mode for smaller file size and better
program security (File => Save Secured RunTime Version). In Default Preferences on the General tab, the Binary RunTime File Format
option is checked by default. Uncheck the box to save the file in ASCII. For added security, HP VEE no longer merges .vxe files into
another program, whether or not the .vxe was saved in the binary format. HP VEE will still import libraries saved as .vxe files.

HP VEE Help

Offers easier access to information:

e Help on objects in a program is accessible by pressing the F1 key when HP VEE is not running. In a program's Detail View, press F1
to get the Help topic for the last-selected object. Otherwise, the HP VEE Help Contents window appears.

The Help menu now includes links to useful Web sites (Windows only).

The HP VEE Help Contents window contains the new heading Guide to HP VEE Example Programs. It contains summaries about the
examples shipped with HP VEE, with links that open examples directly from the Help.
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